Hydrologic Modeling and Predictions for Flood Disaster Mitigation

National Cheng Kung University
Department of Hydraulic & Ocean Engineering
International Master Program on Natural Hazards Mitigation and Management

October 2014

Yasuto TACHIKAWA
Department of Civil and Earth Resources Engineering, Graduate School of Engineering, Kyoto University
<table>
<thead>
<tr>
<th>Day</th>
<th>Duration (h)</th>
<th>Course Outline</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday (Oct. 13)</td>
<td>3</td>
<td>Course introduction</td>
<td>Lecture and discussion</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The science of hydrology</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Hydrologic prediction for planning</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Hydrologic prediction in real-time basis</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Hydrologic prediction for possible maximum hydrologic extreme event</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Modeling of runoff system</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Runoff system and runoff models</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Classification of runoff models</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Lumped rainfall-runoff models</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Basic concept of a distributed rainfall-runoff model</td>
<td></td>
</tr>
<tr>
<td>Tuesday Oct. 14</td>
<td>3</td>
<td>Flood routing in channel network</td>
<td>Lecture and discussion</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Structure of river basin and channel network</td>
<td>Chapter 2 and 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Hydrologic flood routing</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Hydraulic flood routing</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Surface and subsurface runoff in hillslope</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Kinematic wave theory in runoff processes</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Modeling of hill slope flow</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Solution of kinematic wave flow</td>
<td></td>
</tr>
<tr>
<td>Wednesday (Oct. 15)</td>
<td>3</td>
<td>Demonstration of distributed rainfall-runoff modeling using 1K-FRM/DHM</td>
<td>Practice for hydrologic modeling</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Preparation of topographic data</td>
<td>Chapter 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Preparation of rainfall data</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Flow simulation using 1H-FRM/DHM</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Output data analysis</td>
<td></td>
</tr>
<tr>
<td>Thursday (Oct 16)</td>
<td>3</td>
<td>Student presentation and discussion on Distributed rainfall-runoff modeling, 1K-DHM</td>
<td>Student presentation and discussion</td>
</tr>
<tr>
<td>Friday (Oct 17)</td>
<td>3</td>
<td>Flood and water resources projection under a changing climate</td>
<td>Lecture and discussion</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Climate change scenario and GCM data</td>
<td>Chapter 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Bias correction method</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Hydrologic simulation under a changing climate in Southeast Asian region</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Change of flood and drought risk</td>
<td></td>
</tr>
<tr>
<td>Saturday (Oct 18)</td>
<td>3</td>
<td>Verification of study achievement</td>
<td></td>
</tr>
</tbody>
</table>
Table of Contents

1. Modeling of Rainfall-Runoff System .................................................. 1
   1.1 Runoff System and Runoff Model ................................................. 1
       1.1.1 Rainfall-runoff system .................................................. 1
       1.1.2 Components of runoff system and runoff model ....................... 3
       1.1.3 Purposes of rainfall-runoff modeling .................................. 6
   1.2 Basic Concept of Distributed Rainfall-Runoff Model ......................... 6
       1.2.1 Open-book type catchment modeling .................................. 6
       1.2.2 Catchment modeling using digital elevation model ..................... 7
       1.2.3 Flow modeling in hillslopes and channel network ..................... 8

2. Flood Routing in Channel Netowrk .................................................... 11
   2.1 Structure of River Basin and Channel Network ................................ 11
   2.2 Hydrologic Flood Routing ........................................................ 12
       2.2.1 Linear reservoir routing model ........................................ 13
       2.2.2 Muskingum method ...................................................... 13
   2.3 Hydraulic Flood Routing .......................................................... 13
       2.3.1 Dynamic wave model .................................................... 14
       2.3.2 Kinematic wave model .................................................. 14

3. Surface and Subsurface Runoff in Hillslope ....................................... 17
   3.1 Kinematic Wave Theory for Overland Flow .................................. 17
       3.1.1 Kinematic wave flow on a rectangular slope ......................... 18
       3.1.2 Solution of kinematic wave flow ..................................... 19
   3.2 Modeling of Hillslope Flow ..................................................... 19
       3.2.1 Integrated surface-subsurface flow representation .................. 19
       3.2.2 Extension of integrated surface-subsurface flow model ............. 21
4. Distributed Flow Routing Model: 1K-FRM-event

4.1 Preparation of Basin Topographic Data ........................................... 23
   4.1.1 Input data file for hydroshed2topo ....................................... 23
   4.1.2 Parameter file for hydroshed2topo ....................................... 24
   4.1.3 Generation of basin topographic data ..................................... 25
   4.1.4 Output files .............................................................. 25
   4.1.5 Displaying the output files ............................................. 27
4.2 Preparation of Rainfall Data ......................................................... 28
4.3 Flow Simulation Using 1K-FRM-event .............................................. 30
   4.3.1 Basin topography data setting ........................................... 30
   4.3.2 Rainfall data setting .................................................... 30
   4.3.3 Runoff simulation parameter setting ................................... 30
   4.3.4 Rainfall-runoff simulation ............................................. 32
   4.3.5 Compile ................................................................. 33
4.4 Output Data Analysis ................................................................. 34
   4.4.1 Visualization of time and space change of discharge using GRADS ... 34
   4.4.2 Visualization of time and space change of discharge using IrfanView 34
   4.4.3 Time series of discharge data at specific point ....................... 36

5. Water Resources Projection under a Changing Climate ...................... 37

5.1 Climate Change Scenario and GCM data ......................................... 37
5.2 Bias Correction Method .............................................................. 38
   5.2.1 Delta method ............................................................. 38
   5.2.2 Traditional bias-correction method .................................... 39
   5.2.3 Quantile mapping bias-correction method ............................ 39
   5.2.4 Application of bias correction method ................................ 42
5.3 River Flow Simulation in Indochina Peninsula ................................ 44
   5.3.1 Change of water resources ............................................. 44
   5.3.2 Change of flood risk .................................................... 45
   5.3.3 Change of drought risk .................................................. 46

References ......................................................................................... 46

Reference Book .................................................................................. 47
1. Modeling of Rainfall-Runoff System

One of the main tasks of the hydrologists is to predict the hydrograph from knowledge of rainfall, snowmelt and evapotranspiration information under an initial condition (initial soil water) and catchment physical characteristics (topography, soil, vegetation) of the study basin. The hydrologic cycle of a river basin can be regarded as a runoff system in which hydrologic processes such as evaporation, transpiration, infiltration, subsurface runoff, and surface runoff interact with each other. A straightforward way to predict the hydrograph is to represent the runoff system by combining mathematical descriptions of dominant hydrologic processes. This mathematical representation is called a rainfall-runoff model. A rainfall-runoff model plays a major role for river planning and river basin management. Simple conceptual runoff models have been used for a long time. Recently, detailed spatially distributed models and land surface hydrologic models have been developed based on the advancement of observation technology and hydrologic information such as radar rainfall observation, remote sensing of land surface information, and geographical information of river basins.

Keywords: runoff system, rainfall-runoff model, distributed rainfall-runoff model, land surface hydrologic model

1.1 Runoff System and Runoff Model

1.1.1 Rainfall-runoff system

Rainfall on a catchment moves through various pathways and goes into a river channel. This process can be regarded as a runoff system that consists of various interrelated subsystems that transform inputs into outputs. Runoff analysis is to analyze the runoff system to clarify a physical or statistical principle that subsystems are governed, to elu-
cidate the interrelationship among the subsystems, and to create a mathematical model that represents a behavior of a subsystem and an interrelationship of subsystems, and to predict rainfall-runoff phenomena. Takasao clearly defines a runoff system and the research direction to understand the runoff system as below (Takasao, 1967, 1975):

A runoff system refers to an ordered set of homogeneous subsystems that are governed by a physical or statistical principle. Therefore, to understand the characteristics of a runoff system consistently and quantitatively, it is necessary to clarify the mechanism of subsystems and the interrelationship among the subsystems, and to express the entire system systematically.

**Fig. 1.1** shows a block diagram of a runoff system, which represents the route of precipitation which fall on a catchment, in other words, the interrelationship of hydrologic subsystems. A rectangular block stands for a subsystem; a circular block for an input or output; and an arrow for the direction of input.
and output. There are three major physical quantities that characterize the runoff system;

**Input** An external cause that acts on the system, for example, rainfall.

**Output** A result brought by the system with one or more inputs, for example, slope runoff.

**System parameter** Parameters that control the dynamic behaviors of the system, for example, topography gradient, runoff recession constant and so on.

An output of a subsystem may serve as an input to other subsystems that the arrow indicates, and vice versa.

Clarification of a runoff system requires wide range of studies, which are classified into two types: (1) observation of runoff phenomena and (2) development of a mathematical model that expresses the behaviors of a runoff system. These studies are closely associated with each other. An observation target and its time and space resolutions depend on a mathematical model, and a representation of a mathematical model is definitely based on the observation of runoff phenomena. To recognize the observation and the model development interact for each other is the way to understand a runoff system properly.

A runoff system consists of the natural processes shown in **Fig. 1.1** and various human interventions such as water intake from river and groundwater, dam reservoir operations, as well as the transfer/diffusion process of sediment, substances, water quality and temperature that occur in association with the hydrologic cycle.

To predict the runoff phenomena, understanding of the subsystems and the interrelation among subsystems are fundamental. The entire system model is developed by combining the mathematical subsystem models which represent the hydrologic behaviors of subsystems.

### 1.1.2 Components of runoff system and runoff model

**Fig. 1.2** shows an example of a spatial division of a catchment to identify the sub-basin that connect to each channel segment. A runoff system of each sub-basin as shown
Fig. 1.2: Sub-catchment that forms a part of the entire hydrologic system.

in Fig. 1.1 is modeled as a sub-basin rainfall-runoff model and the sub-basin models are connected to develop the entire runoff system model. Major subsystem components in a runoff system are as follows:

**Hillslope runoff system** that receives precipitation and transforms it into surface runoff and subsurface runoff.

**River flow system** that receives hillslope discharge and groundwater discharge, and routes them downstream.

**Groundwater system** that receives infiltration from the hillslope system and provides groundwater discharge to the river system. The groundwater system and the river system interactively exchange the discharge. In an alluvial fan and its downstream area, the river water may be supplied from the river system to the groundwater system.

**Inundation system** that receives precipitation and flood water from the river system and distributes flood water to a flood plain or urban district.

**Human system** that gives an impact on the natural hydrologic cycle such as dam reser-
voir control for flood disaster mitigation/prevention, water supply for agricultural, industrial and urban use; water intake from the river system and the groundwater system for agricultural, industrial and urban use.

Various subsystems in association with the hydrologic cycle such as sediment runoff, substances movement, water quality and water temperature change, vegetation growth.

A runoff model refers to a mathematical system model that expresses the hydrologic behaviors of a subsystem using governing equations, which enables to predict runoff phenomena. Adding components of a runoff system described above, a rainfall system and an evaporation system also play an important role of subsystems. Fig. 1.3 illustrates the flow of water in a sub-basin, where hillslope flow and river flow routing are dominant hydrological processes. Runoff and flood routing of an entire basin are modeled by spatially combining sub-basin models representing hillslope flow and river flow processes.

In the hydrologic cycle, people use the water and modify the natural hydrologic cycle. Irrigation and drainage projects for agriculture, water supply and sewage system development, reservoir operations for flood control and various water use are major human intervention for the natural hydrologic cycle. These processes influence each other and constitute an actual runoff system. River flow is no longer a natural process, which receives impact of human activities. For river planning and river basin management, a hydrologic simulation model that explicitly includes the effect of human activities on the hydrologic cycle can reproduce actual runoff behaviors and predict future runoff phenomena.
1.1.3 Purposes of rainfall-runoff modeling

One of the purposes of a rainfall-runoff model is to understand a runoff system and clarify the interrelationship of subsystems. Engineering purposes include to design of hydraulic structures for flood control and water resources, to predict the river flow for mitigation of flood and drought disasters, and evaluation of river flow change due to basin environment change such as

1. understanding of the hydrologic cycle
2. river flow prediction for river planning
3. real-time river flow forecasting
4. long-term river flow predictions for water resources
5. prediction of the hydrologic cycle under environmental change
6. predictions in ungauged basins

The structure of a runoff model is different due to its purpose.

1.2 Basic Concept of Distributed Rainfall-Runoff Model

1.2.1 Open-book type catchment modeling

A simple representation of basin topography is provided by an open-book catchment model as shown in Fig. 1.4(a). As its name implies, an open-book catchment model consists of two rectangular planes and a stream. Rain water flows on the planes and flows into the stream, and then the stream flow is routed to the basin outlet. The flows on the rectangular plane and the stream are routed using a flow model such as the kinematic wave model. This forms a simple approximation of catchment hydrology. The entire system model is constructed by a cascade of the open-book element models as shown in Fig. 1.4(b). Spatial distribution information of topography, soil characteristics, land cover and rainfall intensity are used for each modeling of sub-catchment.
1.2 Basic Concept of Distributed Rainfall-Runoff Model

(a) Schematic drawing of an open-book catchment model  
(b) Cascade of the open-book catchment model

Fig. 1.4: Catchment modeling

Fig. 1.5: Flow direction information generated from a digital elevation model

1.2.2 Catchment modeling using digital elevation model

Digital elevation models (DEMs) are available at any catchments with a high spatial resolution enough to describe local catchment topography. For example, HydroSHED (Hydrological data and maps based on SHuttle Elevation Derivatives at multiple Scales, http://hydrosheds.cr.usgs.gov/index.php) provides hydrographic information for regional and global-scale, which includes digital elevations, flow directions determined by the steepest gradient with the eight direction method (Fig. 1.5), and flow accumulation with the spatial resolutions of 3 arc-second (about 100m), 15 arc-second (about 500m) and 30 arc-second (about 1km).

After deriving the flow direction information, it is easy to define a river basin to
contribute the outlet of a basin, as shown in Fig. 1.6, which is formed a set of slope units connected according to the flow direction using a 250m resolution DEM. Fig. 1.7 is a schematic drawing of distributed flow modeling on the derived flow direction information. For each slope unit, its area, length and gradient used for a flow model are easily calculated using DEMs. A rainfall-runoff is applied to slope units and generated runoff is routed according to the flow direction information. Not only water movements, sediment and substance movements are also calculated based on the spatial distribution of rainfall intensity, topography, geography, and land use. As one of distributed model, 1K-FRM is introduced in Chapter 4.

1.2.3 Flow modeling in hillslopes and channel network

To represent flows in hillslopes and a channel network, various numerical models are used. To calculate runoff from hillslopes, rainfall-runoff models such as Tank Model, TOPMODEL, the kinematic wave model are used. To calculate river flow, a flow routing
model such as Muskingum method, kinematic wave model, dynamic wave method is used. Model selection is due to the purpose of hydrologic and hydraulic analysis.

A physically-based flow model for hillslope flow is the kinematic wave model. Assuming a rectangular slope as shown in Fig. 1.8, $x$ is the distance measured perpendicularly from the upper end of the hillslope $t$ is time; $r(x,t)$ is rainfall intensity; $e(x,t)$ is evapotranspiration rate; $p(x,t)$ is infiltration rate; $q(x,t)$ is unit width flow rate from of the hillslope; $h(x,t)$ is water depth measured perpendicularly from the hillslope; and $L$ is the hillslope length. Subtraction of evaporation and infiltration intensity from rainfall intensity forms the effective rainfall intensity $r_e$, and suppose that it is supplied to the hillslope. The equation of continuity and the equation of motion of the hillslope flow are

\[
\frac{\partial h}{\partial t} + \frac{\partial q}{\partial x} = r_e(x,t) = \{r(x,t) - p(x,t) - e(x,t)\} \cos \theta
\]

\[
q = f(x,h)
\]

The unit width flow rate at the lower end of the hillslope is given as $q(L,t)$.

The hillslope runoff is the input to the river routing model. The continuity and momentum equations of the channel flow routing are expressed as

\[
\frac{\partial A}{\partial t} + \frac{\partial Q}{\partial y} = q_L(y,t)
\]

\[
Q = g(y,A)
\]
where $q_L(y, t)$ is the slope runoff at distance $y$ along the river channel, $Q(y, t)$ is the flow rate of the river channel, $A(y, t)$ is the flow area. By connecting flow routing model spatially, an entire distributed rainfall-runoff model is constructed.

**References**


2. Flood Routing in Channel Network

A river basin consists of a channel network and hillslopes. Hillslopes convert precipitation falling on hillslopes into runoff and a channel network transports water and sediment to the basin outlet. To predict a downstream hydrograph from the upstream hydrograph is known as flood routing. This chapter deals with a spatial structure of a river channel network and flood routing to understand flood movement from upstream to downstream.

Keywords: river basin, channel network, hydraulic flood routing, hydrologic flood routing

2.1 Structure of River Basin and Channel Network

A river basin consists of interconnected hillslopes and a channel network. A structure of a channel network constitutes the skeleton of topography of a river basin. Fig. 1.2 shows an example of a spatial division of a river basin which consists of sub-basins connecting to each channel segment. Rainfall on the sub-basins is converted to slope runoff and the runoff reaches a channel network. Then, the river flow is routed through a channel network from upstream to the downstream. Fig. 1.3 illustrates the flow of water in a sub-basin. Runoff from of each sub-basin is modeled as a rainfall-runoff model such as a kinematic wave model. To predict a downstream hydrograph from the upstream hydrograph is called flood routing. A flood routing model collects the rainfall-runoff from the sub-basins and routes it from upstream to the downstream through a channel network.

To represent water and sediment transport in a river basin, it is necessary to express the connection of river segments mathematically. Fig. 2.1 shows a channel network and the mathematical representation with a matrix form. The first column is the identification
number of each channel segment. The second to the forth columns are the number of the downstream river segment, the upstream right and left river segments. If channel segments of interest do not exist, 0 is filled for the segments.

To calculate river flow, it is essential to start from the upper channel segment, because flow rate from the upstream channel segment is necessary to calculate the flow rate of the study segment. To calculate river flows using a dynamic wave model, water level at the lower end of channel segment is also necessary. The information connection matrix is used for a channel flow calculation.

2.2 Hydrologic Flood Routing

To calculate the movement of flood flow from the upstream to the downstream is called flood routing. Flood routing is categorized into two types: hydrological flood routing and hydraulic flood routing. Hydrologic flood routing methods consist of a continuity equation and a relationship between storage and inflow and outflow in the channel segment. Typical hydrologic routing methods are the linear reservoir routing model and the Muskingum method. To estimate flow velocity and stage, hydraulic flood routing is commonly used. Hydraulic routing methods are explained in the next section.
2.2.1 Linear reservoir routing model

Consider a channel segment. A continuity equation in the channel segment is

\[ \frac{dS}{dt} = I(t) - Q(t) \]  

(2.1)

where \( I(t) \) is the inflow to the upstream end at time \( t \); \( Q(t) \) is the outflow from the downstream end; and \( S(t) \) is the storage in the channel segment. The hydrologic routing model assumes a relation among \( S, Q, \) and \( I \) as

\[ S = f(I, \frac{dI}{dt}, \frac{d^2I}{dt^2}, \ldots, Q, \frac{dQ}{dt}, \frac{d^2Q}{dt^2}, \ldots) \]  

(2.2)

The routing model is sometimes called a reservoir model. Given an initial value of \( S(t) \) and time series of \( I(t) \), the outflow from the channel segment \( Q(t) \) is solved as an initial value problem of ordinary differential equations. Among the relationship (2.2), the simplest relation is

\[ S(t) = kQ(t) \]  

(2.3)

where \( k \) is a positive constant. This model is known as the linear reservoir model.

2.2.2 Muskingum method

Suppose that the storage of a channel segment \( S(t) \) is expressed as the linear sum of the inflow \( I(t) \) and the outflow \( Q(t) \) as

\[ S(t) = kQ(t) + kx[I(t) - Q(t)] = k[xI(t) + (1 - x)Q(t)] \]

where \( k \) and \( x \) are positive constants. The difference from the linear reservoir model is that the storage is a linear function of the outflow and the inflow.

2.3 Hydraulic Flood Routing

Hydraulic flood routing methods provide flow rate and stage along a channel segment. Hydraulic routing methods are classified in the kinematic wave model, the diffusion wave model, and the dynamic wave model. The difference of the methods is the momentum equation, which are used selectively depending on the gradient of the river channel.
2.3.1 Dynamic wave model

The momentum equation of an open channel flow for the dynamic wave model is

$$\frac{1}{g} \frac{\partial u}{\partial t} + \frac{u}{g} \frac{\partial u}{\partial x} + \frac{\partial h}{\partial x} = i_0 - I_f - \frac{u q_l}{g A}$$

(2.4)

where $t$ is the time coordinate; $x$ is the space coordinate; $u$ is the mean cross-sectional flow velocity ($= Q/A$); $A$ is the cross-sectional area of the flow; $Q$ is the flow rate; $q_l$, the lateral inflow intensity per unit length along the flow direction; $h$ is the water depth measured perpendicularly from the bed slope; $i_0$ is the bed slope; and $I_f$ is the gradient of the friction loss. Substituting below equations into Eq.(2.4) to delete $\partial u/\partial t$ and $\partial u/\partial x$

$$A \frac{\partial u}{\partial t} = \frac{\partial Q}{\partial t} - u \frac{\partial A}{\partial t}, \quad A u \frac{\partial u}{\partial x} = \frac{\partial (Q u)}{\partial x} - u \frac{\partial Q}{\partial x}$$

and using the continuity equation

$$\frac{\partial A}{\partial t} + \frac{\partial Q}{\partial x} = q_l$$

(2.5)

the momentum equation of the one-dimensional dynamic wave model is derived as

$$\frac{\partial Q}{\partial t} + \frac{\partial}{\partial x} \left( \frac{Q^2}{A} \right) + g A \frac{\partial h}{\partial x} = g A (i_0 - I_f)$$

(2.6)

The continuity equation (2.5) and the momentum equation (2.6) are the equations for the one-dimensional dynamic wave model.

2.3.2 Kinematic wave model

When the bed slope is steep, the terms of $i_0$ and $I_f$ are dominant. In the case, the momentum equation (2.6) is

$$0 = i_0 - I_f$$

Using Manning’s mean velocity formula, the mean flow velocity $u$ is

$$u = \frac{1}{n} I_f^{1/2} R^{2/3}$$

where $n$ is the Manning’s roughness coefficient. Then, $Q$ is expressed as

$$Q = A u = \sqrt[3]{I_f} A R^{2/3}$$
2.3 Hydraulic Flood Routing

In general, the hydraulic radius \( R \) has a relation with the flow-sectional area \( A \) as \( R = \xi A^\zeta \), where \( \xi \) and \( \zeta \) are constant parameters. Using the relation and \( I_f \simeq i_0 \),

\[
Q = \frac{\sqrt{I_0}}{n} \xi^{2/3} A^{1+2/3 \zeta} = \alpha_a A^m
\]

is obtained, where

\[
\alpha_a = \frac{\sqrt{I_0}}{n} \xi^{2/3}, \quad m = 1 + \frac{2\zeta}{3}
\]

The continuity equation (2.5) and Eq.(2.7) are the basic equations for the kinematic wave model.

---

**Example 2.1 River channel parameters in various cross sections**

Suppose that when \( \xi \) and \( \zeta \) are constants, the relationship between the hydraulic radius \( R \) and the flow area \( A \) is expressed as \( R = \xi A^\zeta \). Calculate the values of \( \xi \), \( \zeta \) for a wide rectangular cross section, a triangular cross section, and a parabolic cross section \( y = ax^2 \). Then, calculate \( \alpha_a \) and \( m \) in Eq.(2.8) for each cross section.

*(Solution)*

When the cross section of the river channel is a wide rectangle, suppose that the width of the river channel is \( B \) and the water depth is \( h(= A/B) \), as shown in Fig. 2.2(a). Then, \( R \) is given by

\[
R = B h/(B + 2h) \simeq h = (1/B) A
\]

Therefore, \( \xi = 1/B \) and \( \zeta = 1 \). Hence,

\[
\alpha_a = \frac{\sqrt{I_0}}{n} \xi^{2/3} = \frac{\sqrt{I_0}}{n} \left( \frac{1}{B} \right)^{2/3}, \quad m = 1 + 2\zeta/3 = 5/3 = 1.67
\]

When the cross section of the river channel is triangular, suppose that the cross section is represented by Fig. 2.2(b). Then, the flow area \( A \) and the wetted perimeter \( s \) are given by

\[
A = h^2 \tan \phi, \quad s = 2h/ \cos \phi
\]

Therefore, \( R = A/s = h \sin \phi/2 = \sqrt{\sin 2\phi/8} \sqrt{A} \). Hence, \( \xi = \sqrt{\sin 2\phi/8} \) and \( \zeta = 1/2 \). Here,

\[
\alpha_a = \frac{\sqrt{I_0}}{n} \xi^{2/3} = \frac{\sqrt{I_0}}{n} \left( \frac{\sin 2\phi}{2} \right)^{1/3}, \quad m = 1 + 2\zeta/3 = 4/3 = 1.33
\]
When the cross section of the river channel is parabolic, suppose that the cross section is represented by Fig. 2.2(c) where \( y = ax^2 \). Then, the flow area \( A \) and the wetted perimeter \( s \) are given by

\[
A = 2 \int_0^h \sqrt{y} \frac{dy}{a} = \frac{4}{3\sqrt{a}} h^{3/2} = \frac{2hT}{3}
\]

\[
s = 2 \int_0^{T/2} \sqrt{1 + \left(\frac{dy}{dx}\right)^2} dx = 2 \int_0^{T/2} \sqrt{1 + 4a^2x^2} dx
\]

where \( T \) is the width of the flow surface and \( T/2 = \sqrt{h/a} \). To obtain \( s \), we use \( \sqrt{1 + w} = 1 + w/2 - w^2/8 + \cdots \), \((-1 < w < 1)\). Then, we find

\[
\sqrt{1 + 4a^2x^2} = 1 + 4a^2x^2/2 - (4a^2x^2)^2/8 + \cdots, \ (h/T < 1/4)
\]

Here, using the relation of \( a = h/(T/2)^2 \),

\[
s = 2 \int_0^{T/2} \left(1 + \frac{4a^2x^2}{2} - \frac{(4a^2x^2)^2}{8} + \cdots\right) dx = T \left\{1 + \frac{2}{3} \left(\frac{2h}{T}\right)^2 - \frac{2}{5} \left(\frac{2h}{T}\right)^4 + \cdots\right\}
\]

Therefore, if the water surface width \( T \) is sufficiently larger than the water depth \( h \), then

\[
R = A/s = 2h/3 = (a/6)^{1/3} A^{2/3}
\]

and \( \xi = (a/6)^{1/3} \) and \( \zeta = 2/3 \).

\[
\alpha_a = \frac{\sqrt{\xi}}{n} \xi^{2/3} = \frac{\sqrt{\xi}}{n} \left(\frac{a}{6}\right)^{2/9}, \quad m = 1 + 2\zeta/3 = 13/9 = 1.44
\]
3. Surface and Subsurface Runoff in Hillslope

Topography of a river basin consists of hillslopes and river channel networks. A hillslope is a field that transforms rainfall to runoff. Precipitation falling on a hillslope is partly intercepted by trees and vegetation and the rest of it reaches the ground. Some of which infiltrates into the surface soil layer, and some contributes to surface and subsurface runoff. The surface runoff forms overland flow, which occurs as saturated return flow or Hortonian overland flow. Near the surface quick subsurface flow happens. Overland flow and quick subsurface flow are main source of flood flow. This chapter explains a kinematic wave model that describes overland flow and shallow subsurface flow at a hillslope and discusses its analytical solution using the method of characteristics.

Keywords: overland flow, surface runoff, subsurface runoff, kinematic wave model, the method of characteristics, time of concentration

3.1 Kinematic Wave Theory for Overland Flow

The runoff processes are divided into two flow processes: a rainfall-runoff process that explains runoff generation in a hillslope, and a routing process that explains flow through hillslopes. Flow in a hillslope is classified into three types: overland flow on a hillslope surface, subsurface flow in a shallow soil layer and base flow. Overland flow is formed when rainfall intensity exceeds infiltration capacity (infiltration-excess overland flow or Hortonian overland flow) and when a surface soil layer is saturated (saturation-excess overland flow). A physical expression of overland flow is derived from the kinematic wave approximation of the one-dimensional open-channel flow.
3.1.1 Kinematic wave flow on a rectangular slope

Overland flow on a hillslope is considered to be sheet flow on a wide rectangular cross-section channel. As shown in Fig. 3.1 and Fig. 3.2, B is the width of a slope; L is the slope length; $\theta$ is the slope gradient; $q$ is the flow rate per unit width; $h$ is the depth of flow measured perpendicularly from the slope bed; and $r$ is the rainfall intensity given perpendicularly to the slope.

For a rectangular cross-section channel, $Q = Bq$ and $A = Bh$. The lateral inflow $q_L$ to the slope is given by rainfall. The lateral inflow rate per unit length along the flow direction is defined as $q_L = Br$. Substituting these equations into Eq.(2.4) and dividing its both sides by $B$, the continuity equation becomes

$$\frac{\partial h}{\partial t} + \frac{\partial q}{\partial x} = \frac{q_L}{B} = r \tag{3.1}$$

For the momentum equation, substituting $Q = Bq$ and $A = Bh$ into Eq.(2.7),

$$q = \frac{1}{B}\alpha_a (Bh)^m \tag{3.2}$$

is obtained. For a wide rectangular cross-section channel, the hydraulic radius $R$ is expressed as $R = Bh/(2h + B) \approx h$. Using the relation $R = \xi A^\zeta$,

$$R = \xi A^\zeta = \xi (Bh)^\zeta = \xi B^\zeta h^\zeta = h$$

Thus $\zeta = 1$ and $\xi = 1/B$. By substituting this into Eq.(2.8),

$$\alpha_a = \frac{\sqrt{\sin \theta}}{n} \xi^{2/3} = \frac{\sqrt{\sin \theta}}{n} B^{-2/3}, \quad m = 1 + \frac{2\zeta}{3} = \frac{5}{3}$$

is obtained. Therefore, Eq.(3.2) can be expressed as

$$q = \frac{1}{B} \frac{\sqrt{\sin \theta}}{n} B^{-2/3} (Bh)^{5/3} = \frac{\sqrt{\sin \theta}}{n} h^{5/3} = \alpha h^m \tag{3.3}$$
3.2 Modeling of Hillslope Flow

Fig. 3.2: Cross-section of shallow water flow on a rectangular plane.

where

\[ \alpha = \frac{\sqrt{\sin \theta}}{n}, \quad m = \frac{5}{3} \]

The basic equations for the kinematic wave approximation for overland flow on a rectangular plane in Fig. 3.1 and Fig. 3.2 is expressed using Eq. (3.1) and Eq. (3.3). The depth and flow rate at the lower end at time \( t \) is represented as \( h(L, t) \) and \( q(L, t) \).

3.1.2 Solution of kinematic wave flow

To solve the kinematic wave flow equations, the method of characteristics is commonly used. Some special condition, it is possible to obtain an analytical solution. Generally, finite-differential methods is used for computer simulations such as

- the Lax-Wenndroff method
- the four point box method

The Lax-Wenndroff method is an explicit method and the four point box method is an implicit method.

3.2 Modeling of Hillslope Flow

3.2.1 Integrated surface-subsurface flow representation

The surface layer of hillslopes has high permeability in general, and rainwater that reaches the ground surface infiltrates into the surface soil layer. Rainwater that infiltrated into the surface layer first moves vertically downward, and after reaching a place with low permeability such as the bed rock surface, it begins to move sideways. This flow is called
Fig. 3.3: Kinematic wave model integrating surface-subsurface flow.

an **subsurface flow**. When the surface soil layer is saturated, the subsurface flow reaches the ground surface, leading to an overland flow. A model that combines such an subsurface flow and an overland flow is the integrated kinematic wave model for subsurface flow and overland flows.

**Fig. 3.3** illustrates the structure of an subsurface flow and an overland flow, where $L$ is the slope length; $\theta$ is the slope gradient; $D$ is the thickness of the surface soil layer; $H_a$ is the water depth of the subsurface flow; $H_s$ is the water depth of the overland flow; $v_a$ is the velocity of the subsurface flow (the actual velocity of water moving through voids); $v_s$ is the velocity of the overland flow; $r$ is the rainfall intensity measured perpendicularly to the slope; and $p$ is the intensity of infiltration from the bottom of the surface soil layer.

The surface soil layer of hillslopes is very conductive, and therefore, we suppose that when the surface soil layer is unsaturated, rainwater immediately infiltrates and joins the subsurface flow, not remaining on the ground surface. In other words, when $H_a < D$, $H_s = 0$. Inversely, when $H_s > 0$, the surface soil layer is saturated, and therefore, $H_a = D$.

The cross-sectional area of flow $h$, as illustrated above, is defined as

$$h = \gamma H_a + H_s$$

(3.4)

where $\gamma$ is the effective porosity of the surface soil layer. The flow rate per unit width $q$ of the subsurface flow and the overland flow is defined as

$$q = H_a v_a + H_s v_s$$

(3.5)

The cross-sectional area of the subsurface flow is $\gamma H_a$ and the flow rate per unit width of the subsurface flow is $q = H_a v_a$. Therefore, the actual velocity in the soil layer $a$ is defined as

$$a = \frac{q}{\gamma H_a} = \frac{v_a}{\gamma}$$
3.2 Modeling of Hillslope Flow

![Graph showing q-h relationship for a surface-subsurface flow model.](image)

**Fig. 3.4:** $q - h$ relationship for a surface-subsurface flow model.

Here, $v_a = q/H_a$ is the mean cross-sectional flow velocity. According to Darcy’s law, $v_a = k \sin \theta$, where $k$ is the hydraulic conductivity of the surface soil layer. Then, the actual flow rate of the subsurface flow $a$ is given by

$$a = \frac{v_a}{\gamma} = \frac{k \sin \theta}{\gamma} \quad (3.6)$$

When $h$ is larger than $\gamma H_2$, overland flow happens. According to the kinematic wave model stated by Eq.(3.3), $H_tv_s = \alpha H_s^{m-1}$. Thus, the flow rate of the overland flow $v_s$ is given by $v_s = \alpha H_s^{m-1}$. To keep the continuity of flow between surface and subsurface flow, we define $v_s$ as

$$v_s = \alpha H_s^{m-1} + a$$

The relationship between $q$ and $h$ is summarized as

$$q(h) = \begin{cases} 
  ah & \text{when } 0 \leq h < d \\
  \alpha(h - d)^m + ah & \text{when } h \geq d 
\end{cases} \quad (3.7)$$

as shown in **Fig. 3.4**, where $d = \gamma D$. The relation and the continuity equation

$$\frac{\partial h}{\partial t} + \frac{\partial q}{\partial x} = r - p \quad (3.8)$$

constitute the integrated kinematic wave model for subsurface and overland flow.

### 3.2.2 Extension of integrated surface-subsurface flow model

Tachikawa et al. proposed a new $q - h$ relation to represent the runoff generation from low to high flow. The soil layer is assumed to consist of large voids where gravity water occurs and a matrix layer where capillary water flows. Suppose that $D$ is the thickness of
the soil layer; $\theta$ is the volumetric moisture content. Capillary water occupies $0 \leq \theta < \gamma_c$, where $\gamma_c$ is the volumetric moisture content equivalent to the field capacity. $d_c (= \gamma_c D$ is considered the saturation volumetric moisture content of the matrix layer except for large voids. Gravity water occupies $\gamma_c \leq \theta < \gamma$, where $\gamma$ represents porosity and $\gamma - \gamma_c$ denotes effective porosity. Here, $d = \gamma D$ and $h = D\theta$. The proposed a new $q - h$ relation is

$$q(h) = \begin{cases} 
 v_c d_c (h/d_c)\beta & 0 \leq h < d_c, \text{ unsaturated flow} \\
 v_c d_c + a(h - d_c) & d_c \leq h < d, \text{ saturated subsurface flow} \\
 v_c d_c + a(h - d_c) + a(h - d)^m & d \leq h, \text{ overland flow}
\end{cases}$$  \hspace{1cm} (3.9)

where $v_c = k_c \sin \theta$, $a = k_a \sin \theta$.

References


4. Distributed Flow Routing
Model: 1K-FRM-event

1K-FRM-event is a distributed flow routing model based on kinematic wave theory. The source programs are coded using C++ language and works under Microsoft windows environment and the Linux environment. All program source codes and input topography data in the Asian region are provided from the home page of Hydrology and Water Resources Research Laboratory at Department of Civil and Earth Resources Engineering, Kyoto University (http://hywr.kuciv.kyoto-u.ac.jp/products/1K-DHM/1K-DHM.html) The input topography data is generated using HydroSHED 30 second digital elevation model and flow direction data. Forcing data to drive 1K-FRM-event such as runoff generation or precipitation is supposed to be hourly gridded data. At first, a method to develop topography data for 1K-FRM-event is described. Then, by using the developed data, an example of rainfall-runoff simulation using 1K-FRM-event is demonstrated. All programs and data is downloadable from the hope page.

4.1 Preparation of Basin Topographic Data

4.1.1 Input data file for hydroshed2topo

To develop basin topographic data, hydroshed2topo is used to create input data for 1K-FRM-event. The basin topographic data for a flow routing model 1K-FRM-event is generated by using the HydroSHED (http://hydrosheds.cr.usgs.gov/) 30-second digital elevation and flow direction data. The DEM and flow direction data with ESRI grid format data for entire Asia (55E,-10S to 180E, 60N) from HydroSHED were downloaded and they were converted to short integer 2-bite binary data format to reduce the file size. These two files:

1) as_dem_30s_clipped_55-10-180-60.bin (246MB)
Fig. 4.1: Setting study area. An example of clipArea.dat.

2) as_dir_30s_clipped_5510-180-60.bin (246MB)

These two data are input files for hydroshed2topo, which are obtained from 1K-FRM homepage.

4.1.2 Parameter file for hydroshed2topo

All necessary topographic input files to run the 1K-FRM-event are created by executing the hydroshed2topo.cc. The program creates additional ESRI ASCII files and those files can be imported to ArcGIS to prepare maps of the study area. First, you need to specify the study area by editing the parameter data file

hydroshed2topo/clipArea.dat

This file is a text data file. The study area is determined as a rectangular region by setting longitude and latitude as shown in Fig. 4.1.

- The first row specifies the number of columns for the study region. The value must be an integer value.

- The second row specifies the number of rows for the study region. The value must be an integer value.
4.1 Preparation of Basin Topographic Data

- The third row specifies Longitude (degree) of South West (lower left) corner of the study area. The value is a real value.

- The forth row specifies Latitude (degree) of South West (lower left) corner of the study area. The value is a real value.

The grid size is supposed to 30 second. The longitude and latitude of the grid center of \( j \) and \( i \)-th cell is set as follows:

\[
\text{longitude} = (\text{int})(\text{SWlon}) \times 3600 + 30 \times j + 15
\]

\[
\text{latitude} = (\text{int})(\text{SWlat}) \times 3600 + 30 \times i + 15
\]

4.1.3 Generation of basin topographic data

Compile `hydroshed2topo.cc` to generate `hydroshed2topo.exe` and execute `hydroshed2topo.exe`.

4.1.4 Output files

All output files used for 1K-FRM-event are created in the folder:

`hydroshed2topo/output`

The files generated are below. All data begins from the South-West grid and lining to East, then, moving to the North in the next line, which are typical GrADS data format.

- **modDem.bin** is a corrected elevation (pit removed) data of the study area as shown in Fig. 4.2. The data was written in real 4-byte binary data format.

- **flowDir.bin** is a flow direction data. The direction convention is shown in Fig. 4.3. The data format is integer 4-bit binary.

- **flowAcc.bin** is a flow accumulation data (Fig. 4.4). The data format is integer 4-bit binary.

- **riverNum.bin** includes the information of a basin number starting from 1 and then each grid cell is assign a value corresponding to the basin (Fig. 4.5). The data format is integer 4-bit binary.
Fig. 4.2: A sample of modem.bin.

Fig. 4.3: A sample of flowDir.bin and flow direction specified by the integer value.

Fig. 4.4: A sample of flowAcc.bin.

Fig. 4.5: A sample of riverNum.bin.
### 4.1 Preparation of Basin Topographic Data

<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>129555</td>
</tr>
<tr>
<td>2</td>
<td>497085</td>
</tr>
<tr>
<td>3</td>
<td>497205</td>
</tr>
<tr>
<td>4</td>
<td>497265</td>
</tr>
<tr>
<td>5</td>
<td>497295</td>
</tr>
<tr>
<td>6</td>
<td>497325</td>
</tr>
</tbody>
</table>

**Fig. 4.6:** An example of riverNumList.txt.

**riverNumList.txt** This is a text file shown in Fig. 4.6 which contains:

- **Column 1** river basin number of the study area,
- **Column 2** the basin area (accumulated number of grids),
- **Column 3** column number starting from 1 (starting from West),
- **Column 4** row number starting from 1 (starting from South),
- **Column 5** longitude (second),
- **Column 6** latitude (second),
- **Column 7** longitude (degree), and
- **Column 8** latitude (degree)

You can calculate only selected river basins by keeping only the necessary rows and deleting other rows.

### 4.1.5 Displaying the output files

You can display the output files directly using GrADS (http://iges.org/grads/). Sample GrADS control files are attached in hydroshed2topo to visualize the data. To use ArcGIS (http://www.esri.com/), additional files with ESRI ASCII files are also created. These files are

- **cutDem.asc** The DEM data for the study region. This is the original data clipped for the study region.
Fig. 4.7: Part of rain.dat. The 1st Row is: Year, Month, Day, Hour, Column Number, Row Number. From the 2nd to 7th Rows, effective rainfall intensities (5 columns and 6 rows) in mm/hr are stored.

cutDir.asc The DIR data for the study region. This is the original data clipped for the study region.

modDem.asc The DEM data for the study region. This is the corrected (pit removed) elevation information of the study area, which corresponds to moDem.bin.

flowDir.asc The Flow Direction data for the study region, which corresponds to flowDir.bin.

flowAcc.asc Flow accumulation value information, which corresponds to flowAcc.bin.

riverNum.asc The river basin numbers of the study area, which corresponds to riverNum.bin.

distance.asc The distance from the river mouth.

4.2 Preparation of Rainfall Data

It is necessary to create a text file of effective hourly forcing data, which is spatially distributed lateral input data to slope and river such as rainfall intensity or runoff generation intensity data. If the data duration is shorter than simulation time, remaining rainfall is assumed to zero. A part of a sample data file is shown in Fig. 4.7. The rainfall data file name is rain.dat and should be placed at
1k-frm-event/input/rain.dat

The first line of rain.dat is Year, Month, Day, Hour, Column Number, and Row Number of spatially gridded rainfall data. From the next line, rainfall intensity values (mm/hr) are stored beginning from the North-West grid and lining to East, then, moving to the South in the next line. Each data is delimited by white space characters (SPACE, TAB, or CR). You can change the rainfall intensity data for your study purpose.

The coordinate system of the rainfall input data is shown in Fig. 4.8. The rainfall intensity data represents the intensity of each grid center. The time interval of the rainfall intensity must be hour. Fig. 4.9 shows the relation between the basin topography coordinate system and the rainfall coordinate system. For runoff simulation, the nearest grid of rainfall intensity is selected.

The grid size of forcing data is set in the parameter setting file for 1K-FRM-event. The grid center of longitude (degree) and latitude (degree) of j-th column and i-th row for input data are set as follows:

\[
\text{longitude} = \text{ROF_WLON} + j \times \text{Delta}_x \\
\text{latitude} = \text{ROF_SLAT} + j \times \text{Delta}_y
\]
4.3 Flow Simulation Using 1K-FRM-event

The procedures for runoff simulation are as follows.

4.3.1 Basin topography data setting

Copy the basin topographic data files (modDem.bin, flowDir.bin, flowAcc.bin, riverNum.bin and riverNumList.txt) from hydroshed2topo/output/ to 1k-frm-event/topoData/

4.3.2 Rainfall data setting

Set the rain data and place rainfall data file at 1k-frm-event/input/rain.dat. The file name must be rain.dat.

4.3.3 Runoff simulation parameter setting

Edit the runoff simulation parameter file 1k-frm-event/param-event.dat by using any text editor. Delimiter of each data is white space characters. The parameter values to set in param-event.dat shown in Fig. 4.10 are as follows:
4.3 Flow Simulation Using 1K-FRM-event

- From 1st row to 4th row: the parameters of the study region is specified:

  \( \text{int Col} = 120 \)  number of column for study area.

  \( \text{int Row} = 60 \) number of row for study area.

  \( \text{double SWLON} = 138.0 \) Longitude (degree) of north west corner of the study area.

  \( \text{double SWLAT} = 35.5 \) Latitude (degree) of north west corner of the study area.

- From 5th row to 10th row: the parameters of the rainfall data is specified.

  \( \text{int ROFnum\_col} = 5 \) Number of column of input rainfall data

  \( \text{int ROFnum\_row} = 6 \) Number of row of input rainfall data

  \( \text{double Delta\_x} = 0.1875 \) Input data grid size of x-direction (degree)

  \( \text{double Delta\_y} = 0.1875 \) Input data grid size of y-direction (degree)

  \( \text{double ROF\_WLN} = 137.75 \) West corner longitude of input data (degree)

  \( \text{double ROF\_SLAT} = 35.25 \) South corner latitude of input data (degree)

- The 11th row is a parameter to determine the simulation term.

  \( \text{int Ndays} = 10 \) Simulation duration (days)

- From 12th row to 14th row, the parameters for the finite difference condition are specified. Usually, you do not need to change these parameter values.

  \( \text{int Time\_Step} = 600 \) Simulation time step (sec)

  \( \text{int Nspace} = 20 \) Number of spatial divisions

  \( \text{double Theta} = 0.65 \) weight value \( 0.5 < \theta \leq 1.0 \)

- From 15th row to 17th row, parameters for the kinematic wave model are specified.

  \( \text{double Man\_slope} = 0.5 \) Manning \$/s$ roughness coefficient for slope (m-s unit)

  \( \text{double Man\_channel} = 0.03 \) Manning \$/s$ roughness coefficient for river (m-s unit)

  \( \text{int Threshold\_basin} = 250 \) grid accumulated number to differentiate slope and river
120 Number of columns of the study area  
60   Number of rows of the study area  
138.0 Longitude (degree) of South West corner of the study area  
35.5 Latitude (degree) of South West corner of the study area.  
  5   Number of columns of the input forcing data  
  6   Number of rows in the input forcing data  
0.1875 Input data grid size of x-direction (degree)  
0.1875 Input data grid size of y-direction (degree)  
137.75 West corner longitude of input data (degree)  
35.25 South corner latitude of input data (degree)  
  10  Simulation duration (days)  
  600 simulation time step (sec)  
  20  number of spatial divisions  
0.65  0.5 < \theta < 1.0  
0.5   Manning's roughness coefficient for slope (m-s unit)  
0.03  Manning’s roughness coefficient for river (m-s unit)  
250   grid accumulated number to differentiate slope and river  
0.0   Initial runoff height for kinematic wave model (mm/hr)  

Fig. 4.10: An example of `param-event.dat`. The descriptions of the parameters are not included in the file.

- The 16th row is a parameter to determine the initial condition.

  double initialROF = 0.0 Initial runoff height (mm/hr)

4.3.4 Rainfall-runoff simulation

Move to the folder `/project/1k-frm-event` and execute

    1k-frm-event.exe

All runoff simulation results are created in

    1k-frm-event/output

The files created are below:
4.3 Flow Simulation Using 1K-FRM-event

dischargeDaily.bin The file contains the average daily flow (m$^3$/sec).

dischargeHourly.bin The file contains the hourly flow (m$^3$/sec).

dischargeHourlyMaxInDay.bin The file contains the maximum hourly flow value for each day (m$^3$/sec).

The data are stored in GRADS binary data format and can be visualized using GRADS (http://www.iges.org /grads/). All data arranges from west to east at the South row, then North row. GrADS control file:

- flowAnalysisGradsDaily.ctl
- flowAnalysisGradsHourly.ctl

are attached. A sample program is also attached in ./output:

- pointdata-event.cc

which extracts time series ascii data from the above binary data.

4.3.5 Compile

(1) Linux environment

You can change the source code, compile a modified code. The executable is created by using the GNU g++ compiler as following command:

```bash
% g++ -o 1k-frm-event 1k-frm-event.cc cellfunc-event.cc roffunc-event.cc
```

For Intel C++ compiler of Linux version

```bash
% icc -o 1k-frm-event 1k-frm-event.cc cellfunc-event.cc roffunc-event.cc
```

(2) MS Windows environment

Microsoft Visual Studio with C++ compiler is useful. You can download a free version of Visual C++ Express Edition from Microsoft web site. The solution file 1k-frm-event.sln should be created according to the Microsoft Visual Studio to use Visual Studio environment. You can also use the command prompt window of the Microsoft Visual Studio. In this case, after opening the command prompt window, you can compile the program as:
% cl 1k-frm-event.cc cellfunc-event.cc roffunc-event.cc

For Intel C++ compiler of windows version

c:\> icl 1k-frm-event.cc cellfunc-event.cc roffunc-event.cc

4.4 Output Data Analysis

4.4.1 Visualization of time and space change of discharge using GRADS

GRADS is a free visualization software mainly used by meteorologists. The software works on Windows and Linux/Unix environment. GRADS is available from http://www.iges.org/grads/.

You can use an example of GRADS control files flowAnalysisGradsDayly.ctl and flowAnalysisGradsHourly.ctl in /project/misc/gradsControlFiles. Please see the detail information at the web page. Fig. 4.11 is a spatial distribution of discharge at the study region.

4.4.2 Visualization of time and space change of discharge using IrfanView

If you do not have GrADS, you can generate PPM format image files and see it using a free image viewer IrfanView. The procedure to see the animation of time and space
Fig. 4.12: IrfanView Slideshow setting.

Change of discharge is as follows:

1) Run the image generation program makeppm.exe, which is downloaded from 1K-FRM home page. This program reads the GrADS format output hourly discharge data dischargeHourly.bin and generate PPM format image files under image folder. To run the program,

   1-1) Open the folder project/1k-frm-event
   1-2) Click makeppm.exe
   1-3) Image files are generated under project/1k-frm-event/image/.

2) Install IrfanView. This is a very popular free image viewer. Click
   misc/irfanview/irview428_setup.exe

   The viewer is installed and you will find the icon on your MS-Windows desktop.

3) Click the IrfanView icon and select [File] -> [Slideshow] as shown in Fig. 4.12.
   Then, set the location of PPT image file. You can enjoy the animation.
4) Another method to view the animation is to select [File] -> [Open], select the image folder and click the first image. Then, select [View] -> [Start/Stop automatic viewing]. You can select [View] -> [Display option (window mode)] to enlarge the image.

4.4.3 Time series of discharge data at specific point

Procedures to extract the time series of discharge data at a specific point is below:

1) Run the time series extraction program pointdata.exe. This program reads the GRADS format output hourly discharge data dischargeHourly.bin and generates text format time series data under output. To run the program,

1-1) Open the folder 1k-frm-event.

1-2) Click pointdata.exe.

1-3) You will be asked to input the column and row number to extract the data. To determine the column and row number, it is useful to see the accumulated catchment data hydroshed2topoutputESRIBasin.asc to examine the discharge with large catchment size. The row and column number begins from the North West corner starting from 1.

1-4) The extracted data is generated under output Col-Row-discharge.dat. The first column of the data is time count (hour) and the second column is discharge (m3/sec).

2) To draw the hydrograph, you can use Excel or GnuPlot (http://www.gnuplot.info/).

References


5. Water Resources Projection under a Changing Climate

5.1 Climate Change Scenario and GCM data

General circulation models (GCMs) provide future atmospheric and hydrologic variables under various climate change scenarios. The output hydrologic variables are used to various applications of future hydrologic projections to evaluate future water resources under a changing climate. One of the latest GCMs is MRI-AGCM3.2S developed by the Meteorological Research Institute, the Japan Meteorological Agency. The products of MRI-AGCM3.2S consist of various atmospheric and hydrologic variables for the present climate experiment (1979-2008), the near future climate experiment (2015-2044), and the future climate experiment (2075-2104), which were simulated under the SRES A1B scenario. Fig. 5.1 shows the GCM outputs related to the hydrologic cycle.

Recent GCMs adopt new scenarios, the RCP (representative concentration passway)

Fig. 5.1: GCM outputs related to the hydrologic cycle in the MRI-AGCM.
5. Water Resources Projection under a Changing Climate

instead of the SRES scenarios. The RCP scenario assumes a greenhouse gas concentration trajectory for the future. The RCPs have four scenarios, RCP2.6, RCP4.5, RCP6 and RCP8.5. The RCP8.5 is the severest among the four scenarios.

5.2 Bias Correction Method

Most cases, significant differences exist between observed hydrologic variables and GCM outputs. The differences are recognized as the bias of GCMs. The bias correction is an algorithm to generate a new time-series with decreased from GCM outputs. Various bias corrections methods are proposed. Most of cases, bias correction methods are applied on a monthly basis. Below explanation uses the following descriptions:

\[ x_{\text{obs}}(i) \]: daily observed hydrologic variable of the \( i \)-th day,

\[ x_{\text{gcm},p}(i) \]: daily GCM output of the \( i \)-th day for a present climate experiment,

\[ x_{\text{gcm},f}(i) \]: daily GCM output of the \( i \)-th day for a future climate experiment,

\[ \bar{x}_{\text{obs}} \]: monthly mean observed value for entire period,

\[ \bar{x}_{\text{gcm},p} \]: monthly mean of present GCM simulation for the entire simulation period,

\[ \bar{x}_{\text{gcm},f} \]: monthly mean of future GCM simulation for the entire simulation period.

Due to the difference in resolution of the observed values and the GCM outputs, the nearest neighbor method is used to pair these data for identifying the bias pattern.

5.2.1 Delta method

The delta method calculates the differences of the mean values between GCM future and present period and are added to monthly or daily observed values to develop future hydrologic time-series. For example, daily values are developed as follows:

\[ x_{\text{corrected},f}(i) = x_{\text{obs}}(i) + d_d, \quad d_d = \bar{x}_{\text{gcm},f} - \bar{x}_{\text{gcm},p} \]  \hspace{1cm} (5.1)

where \( d_d \) is a monthly mean difference for each month. The ratio \( r_d \) is also used to create time-series as

\[ x_{\text{corrected},f}(i) = x_{\text{obs}}(i) \times r_d, \quad r_d = \frac{\bar{x}_{\text{gcm},f}}{\bar{x}_{\text{gcm},p}} \]  \hspace{1cm} (5.2)
5.2 Bias Correction Method

Rather than bias-correction methods, the delta method generates hypothetical hydrologic time series based on the observed data. The data generation using the difference factor in Eq.(5.1) is usually applied for temperature and the ratio factor in Eq.(5.2) is often used for precipitation to avoid negative precipitation.

5.2.2 Traditional bias-correction method

The bias-correction methods obtain differences in mean values between observation and present GCM simulation for historical reference period and the differences are used to correct future GCM simulations. The simplest bias correction method estimates monthly bias $d_b$ and applies the difference to correct GCM daily output as

$$x_{\text{corrected},f(i)} = x_{\text{gcm},f(i)} + d_b, \quad d_b = \frac{x_{\text{obs}} - x_{\text{gcm},p}}{(5.3)}$$

The ratio $r_b$ is also used to correct the bias as

$$x_{\text{corrected},f(i)} = x_{\text{gcm},f(i)} * r_b, \quad r_b = \frac{x_{\text{obs}}}{x_{\text{gcm},p}} \quad (5.4)$$

The bias is usually calculated for each month and daily GCM outputs are corrected.

5.2.3 Quantile mapping bias-correction method

A bias correction method based on a relationship of cumulative distribution functions (CDFs) of the GCM and observation data have been commonly used for hydrologic simulations and climate change studies. Fig. 5.2 illustrates the flowchart of a quantile mapping bias correction method for daily precipitation. At first, wet day of GCM daily precipitation is defined as the day that rainfall occurred more than a predefined threshold such as 0.1mm/day. Then, the GCM precipitation data is sorted in ascending order to make a cumulative distribution function (CDF) of daily GCM precipitation for each month. Similarly, a CDF of observed daily precipitation data is developed. The numbers of wet days for GCM and observed precipitation are different, thus the difference is corrected by adjusting the wet days of GCM precipitation to match with observation data by setting the GCM precipitation to 0.0mm. Two methods below are applicable using CDFs of observed and GCM daily precipitation.
Fig. 5.2: Flow chart of the precipitation bias-correction using a quantile mapping method.

(1) **Empirical distribution method**

Fig. 5.3 shows an example of cumulative distribution functions (CDFs) of observed and GCM daily precipitation. A number of sub-ranges are set to the CDFs in terms of the non-exceedance probability, for example, 0 to 0.25 \((j=25Q)\), 0.25 to 0.5 \((j=50Q)\), 0.5 to 0.75 \((j=75Q)\) and 0.75 to 1.0 \((j=100Q)\), where \(j\) represents the index of each sub-range. The correction difference \(d_{b,j}\) is obtained for each sub-range as

\[
d_{b,j} = \overline{x}_{\text{ols},j} - \overline{x}_{\text{gcm},p,j}, \ j = 25Q, 50Q, 75Q, 100Q
\]

where \(\overline{x}_{\text{ols},j}\) and \(\overline{x}_{\text{gcm},p,j}\) are the monthly mean values for each sub-range. The bias correction is applied as

\[
x_{\text{corrected},f(i)} = x_{\text{gcm},f(i)} + d_{b,j}
\]

where \(d_{b,j}\) is determined depending on the non-exceedance probability of \(x_{\text{gcm},f(i)}\).

The ratio method is also applicable. The correction ratio \(r_{b,j}\) is obtained for each sub-range as

\[
r_{b,j} = \frac{\overline{x}_{\text{ols},j}}{\overline{x}_{\text{gcm},p,j}}, \ j = 25Q, 50Q, 75Q, 100Q
\]

The bias correction is applied as

\[
x_{\text{corrected},f(i)} = x_{\text{gcm},f(i)} \times r_{b,j}
\]
5.2 Bias Correction Method

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{cumulative_distributions.png}
\caption{Cumulative distributed functions of observed and GCM daily precipitation.}
\end{figure}

where \( r_{b,j} \) is determined depending on the non-exceedance probability of \( x_{\text{gcm},i}(i) \).

(2) Quantile-Quantile method

Quantile-quantile (Q-Q) bias correction method assumes that the bias correction for observed data and GCM outputs at the same non-exceedance probability is applicable for the future GCM output with the same non-exceedance probability as shown in Fig. 5.4. Based on the assumption, the GCM precipitation is mapped onto the observed precipitation at respective non-exceedance probability, or the GCM quantile is mapped onto the observation quantile. To pair the observed data and the GCM output, cumulative distribution functions (CDFs) of both the observation and the GCM output are developed. To identify CDFs, non-parametric empirical distribution is used. Assuming a theoretical distribution function and fitting the data to the distribution function is also useful.

The bias correction method is mathematically expressed by setting the pair with the same non-exceedance probability \( p \) as

\[
p = F_{\text{obs}}(x_{\text{obs}}(p)) = F_{\text{GCM},p}(x_{\text{GCM},p}(p))
\]  \hspace{1cm} (5.9)

where \( F_{\text{obs}}() \) is the CDF of observed data, \( x_{\text{obs}}(p) \) is the observed data with the non-exceedance probability \( p \), \( F_{\text{GCM},p}() \) is the CDF of the GCM output of the present climate, and \( x_{\text{GCM},p}(p) \) is the GCM output with the non-exceedance probability \( p \). The correction
difference is obtained for the same non-exceedance probability as

\[ d_b(p) = x_{\text{obs}}(p) - x_{\text{gcm},p}(p) \]  

(5.10)

The bias correction is applied as

\[ x_{\text{corrected},f}(i) = x_{\text{gcm},f}(i) + d_b(p) \]  

(5.11)

where \( d_b(p) \) is determined depending on the non-exceedance probability of \( x_{\text{gcm},f}(i) \).

The ratio method is also applicable. The correction ratio \( r_b(p) \) is obtained for the same non-exceedance probability as

\[ r_b(p) = \frac{x_{\text{obs}}(p)}{x_{\text{gcm},p}(p)} \]  

(5.12)

The bias correction is applied as

\[ x_{\text{corrected},f}(i) = x_{\text{gcm},f}(i) \times r_b(p) \]  

(5.13)

where \( r_b(p) \) is determined depending on the non-exceedance probability of \( x_{\text{gcm},f}(i) \).

### 5.2.4 Application of bias correction method

Fig. 5.5 is an example of corrected precipitation applying the Q-Q bias correction method with the multiplication factor in Eq.(5.13). APHRODITE is used for the observed daily precipitation and GCM precipitation was daily values provided from MRI-AGCM3.2 for present climate experiment (1979-2007).

Bias correction of evapotranspiration was directly adjusted a mean monthly GCM evapotranspiration by the multiplicative factor and the difference method. The reference
5.2 Bias Correction Method

![Mean Monthly Precipitation in mm (1979-2007)](image)

**Fig. 5.5:** Monthly mean precipitation for observed, GCM and corrected GCM.

![Monthly mean reference evapotranspiration and GCM evapotranspiration for present, future and future experiment by MRI-A-GCM3s.](image)

**Fig. 5.6:** Monthly mean reference evapotranspiration and GCM evapotranspiration for present, future and future experiment by MRI-A-GCM3s.

![Monthly mean GCM evapotranspiration for future climate and the bias-corrected by multiplicative factor method and different factor method.](image)

**Fig. 5.7:** Monthly mean GCM evapotranspiration for future climate and the bias-corrected by multiplicative factor method and different factor method.

data for bias correction is mean monthly evapotranspiration estimated from the observed climatology data over 30 year. **Fig. 5.6** shows the monthly mean of GCM evapotranspiration and monthly estimated values. It clearly shows that in dry season from December to April the GCM evapotranspiration is considerably lower than the estimated values. The large difference in dry season happens because the GCM did not incorporate irrigation effect of the basin. **Fig. 5.7** illustrates average of mean monthly evapotranspiration of corrected and original daily data for future projection period (2075-2013). Difference of the multiplicative and difference method is small, however very high daily corrected values happen in the the multiplicative method. For the result, the different method is better for evapotranspiration.
5. Water Resources Projection under a Changing Climate

5.3 River Flow Simulation in Indochina Peninsula

River discharge projection in Indochina Peninsula region was carried out using MRI-AGCM3.2S. Daily mean discharge, maximum hourly discharge in a day is stored in 5-minute spatial resolution. The simulated river discharge was analyzed to locate possible hotspot basins with significant changes of floods, droughts and water resources.

5.3.1 Change of water resources

Annual mean simulated river discharge for three climate experiments was calculated and used to analyze changes in water resources in Indochina Peninsula region. Fig. 5.8 shows the change ratio of annual mean discharge for the near future climate and the future climate to the present climate experiment. From Fig. 5.8(a), it can be seen that there are not so much changes in annual mean discharge in the near future. Slightly increases in annual mean discharge with the ratio smaller than 1.5 can be detected at the most upper parts of Salween and Mekong River basin, the lower part of Irrawaddy River basin, and western part of Vietnam. Only eastern part of Chao Phraya River basin shows a trend of decreasing in annual mean river flow with the ratio is between 0.5 and 0.9. Fig. 5.8(b) shows a similar trend with higher intensity in the future climate experiment. We can see that the area with changes in annual mean discharge and ratio range become larger, especially at the middle and lower part of Irrawaddy River basin, and eastern part of
Chao Phraya River basin. However, the annual mean flow in the future climate tended to decrease in the central part of Vietnam. The change ratio is lower than 0.9.

5.3.2 Change of flood risk

Annual maximum discharge data for three climate experiments were compiled and were analyzed. The change ratio of mean of annual maximum discharge for the near future climate and the future climate with respect to the present climate experiment are shown in Fig. 5.9. For the near future climate experiment, the mean of annual maximum discharge has significant changes at the upper and lower part of Salween River basin, north-western part of Vietnam, and eastern part of Chao Phraya River basin. The changes, which were detected in the near future climate experiment, become more visible in the future climate experiment. Irrawaddy River basin and Red River basin showed a noticeable increasing of mean of annual maximum discharge in the future climate experiment. The ratio at some areas are larger than 2.5. It means that the risk of flooding at those areas will increase.

The ratio of the standard deviation of the annual maximum discharge for the near future climate and the future climate to the present climate experiment were also calculated and analyzed. The standard deviation also showed a similar trend to the changes of mean of annual maximum discharge. The increases of standard deviation of annual maximum discharge can be found in Irrawaddy River basin, Salween River basin, and Red River basin as shown in Fig. ??.
Fig. 5.10: Ratio of mean of annual minimum discharge for the near future climate to the present climate (a), and the future climate to the present climate (b).

5.3.3 Change of drought risk

The change of drought risk in Indochina Peninsula region was also analyzed by comparing the mean of annual minimum discharge in the near future climate and the future climate experiment with those values in the present climate experiment. From Fig. 5.10, it can be seen that there is a decrease trend at the middle part of Mekong River basin in the territory of Lao PDR, western part of Chao Phraya River basin, and the south-eastern part of Indochina Peninsula, especially the southern part of Vietnam. This trend becomes clearer in the future climate experiment.

References


Reference Book


Consortium for International Human Resource Development for Disaster-Resilient Countries